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INTRODUCTION 
 
Abstract Plus is a free-of-charge, cancer data collection tool developed by the Centers for Disease 
Control and Prevention (CDC) which enables non-registry hospitals within the Commonwealth to 
report cancer cases to the Pennsylvania Cancer Registry (PCR).  The software is customized by 
the PCR to meet all state reporting requirements.   
 
The abstracting capability of Abstract Plus is used to summarize medical records into an 
electronic report of cancer diagnosis and treatment.  Abstract Plus supports the abstraction of all 
data items in the national standard data sets, including all text fields, as well as any state-specific 
data items.  The output of Abstract Plus is an electronic abstract in the format of the North 
American Association of Central Cancer Registries (NAACCR) data exchange layout. 
 
Abstracts entered into Abstract Plus are validated by customizable edits, allowing for interactive 
error correction while abstracting.  Abstract Plus includes Registry Plus Online Help, a collection 
of standard coding manuals that are cross-referenced, indexed and context-linked to minimize the 
need for reference to printed manuals.  Since Abstract Plus includes Online Help screens and 
internal edits, data quality will improve.  Edits have been incorporated into the software so many 
errors will be identified and corrected during abstracting, eliminating some of the follow-up 
questions from PCR staff.  
 
Abstract Plus has enhanced security features.  All records are saved in Microsoft Access or SQL 
server databases, and all tables are password protected and encrypted using Microsoft functions.  
All users must have a User ID and password to access the abstracting features of the application.   
 
This manual provides step-by-step instructions for all the procedures performed throughout 
Abstract Plus.  For detailed instructions on data item completion, please refer to your PCR 
Manual. 
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SYSTEM REQUIREMENTS 
 

Abstract Plus is programmed for the 32- and 64-bit Microsoft® Windows® operating systems on 
x86-compatible processors. The minimum hardware requirements are the same as those of the 
Microsoft Windows operating system used.  
 
Additional system requirements include— 

• Microsoft operating system, Windows XP or later. 
• 128 MB RAM (512 MB recommended). 
• Latest version of Microsoft Internet Explorer (recommended). 
• The available hard disk space requirement for Abstract Plus depends on the number of 

abstracts that will be used. A minimum of 70 MB of free hard drive space is required. 
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DOWNLOADING AND INSTALLING ABSTRACT PLUS 
 

A PA-specific version of Abstract Plus is available for download from the PCR Web site.  
 
You must have administrative privileges to your computer in order to install Abstract Plus.  
Contact your IT staff to install the program if you do not have administrative privileges. 
 
It is recommended that a short-cut icon is placed on your desktop for easier access to Abstract 
Plus. Contact your IT staff if you are unsure how to create a short-cut. 
 
DOWNLOADING: 
 
To download the V15.0 PA-specific Abstract Plus install, complete these steps: 
 
1. Create a temporary folder on your computer to which you will download the install. 
 
2. Go to the PCR Website using the link below.  You can also cut and paste or directly type 

the link in the address field of your Internet browser.  
 
http://www.health.pa.gov/MyRecords/Registries/Cancer/Pages/CancerRegistry.aspx#.Vb
DZGL_D_X4 

 
3. Click on Hospital Reporting (right side of the screen). 

 
4. Scroll down to the section titled Abstract Plus V15.0/Abstract Plus V15.0 Software      

Download-New Install 
 

5. Download the .zip file PAV15.0 Install.zip to the temporary folder and unzip the file.  
This can be done by right clicking on the heading ‘Abstract Plus V15.0 Software 
Download’ and select ‘Save Target As’.  Under ‘Save in:’, select the location of the 
temporary folder and then click on the ‘Save’ button.  After download is complete, go to 
the temporary folder and unzip the file.  There will be two files:  setup.exe and 
AbstractPlus_3.5_V150_PA_.msi.  Both files are needed to complete the installation. 
 

6. Continue with the instructions under INSTALLING below. 
 

 
INSTALLING: 
 
Note:  The below install instructions only applies if this is a brand new install and you do 
not currently have an old version of Abstract Plus on your PC.  If you have an old version, 
contact the PCR for specific instructions on how to uninstall and reinstall. 
 

Install the Abstract Plus version 3.5, NAACCR 15.0 software: 
a. Double-click the setup.exe file that came with the Abstract Plus v3.5, 

NAACCR 15.0 software installation files. 
 Result:  The Abstract Plus Setup Wizard opens. 
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b. Click Next to continue the installation. 
Result:  The Select Installation Folder window opens.  

 
c. Click on Next 
Result:  The Confirm Installation window opens. 
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d. Click Next to confirm you would like to install Abstract Plus. 

Result:  The installation process begins. 

 
When installation has completed, the Installation Complete window 
appears. 
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e. Click Close.  Installation is done. 

 

Setting up Full Control and folder Permissions for User for the Abstract 
Plus folder and all of its subfolders: 
The user must have full control permission to Write/Read on the application 
folder and the MDBS file. 

To grant Full Control permission to the Abstract Plus folder and all of its 
subfolders in Windows 7, complete the following steps: 

a. Locate the Abstract Plus folder: C:\RegPlus\AbstractPlus. 
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b. Right click the AbstractPlus folder and select Properties. 

Result:  The Abstract Plus folder Properties window opens. 

 
c. Click the Security tab. 

Result:  The Security tab window opens. 

August 2015  10 



 
Pennsylvania Cancer Registry (PCR)                             Abstract Plus V15.0 User’s Guide 
 

 
d. Click Edit.  

Result:  The Security tab permissions window opens. 
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e. Select the user/group from the permission window to click add to add 

other user or group. 

Result:  The permissions for the Users account is displayed in the 
lower window 

f. In the lower Permissions for Users window check the Allow 
checkbox to the right of the Full control permission (if full control 
permissions have already been granted, no further action is required). 
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g. Click OK for changes to take effect. 

h. Click OK to exit from Properties window. 

Now you can access files in Windows 7 with full permissions. 
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CREATING A USER ACCOUNT UPON INITIAL ACCESS AND 
FIRST-TIME LOG IN 

 
After installing Abstract Plus, if you are the first person to launch the program, you will be 
prompted to create a new user account.  You will then need to log in using the new login 
information you entered along with an initial password of Welcome1, change your password, and 
then answer security or “challenge” questions. Your answers to these questions will be used to 
validate your identity if you forget your Abstract Plus password---if you forget your password, 
Abstract Plus will ask you for the answers you provided to these security questions, and then 
allow you to reset your password if the questions are answered correctly. 

To create a new user account upon initial launch of the program, and log in to the application for 
the first time complete these steps: 

1. To launch the program, from the Start menu, select All Programs, Registry Plus, Abstract 
Plus, and then Abstract Plus or if you have created an icon on your desk top, double click on 
the icon. 

Result: The Create Users window opens.  

 
2. Enter your full name in the User Name field. The format for name entry is last name, and 

then first name and middle initial, e.g., Smith, John A.  In the example shown, the user name 
being entered has the last name USER, first name NEW, and middle initial A. 
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3. Enter a User ID in the User ID field. User IDs can only be characters (no hyphens), and are 

5-10 characters in length. In the future, you will enter your User ID when logging in to 
Abstract Plus. In the example shown, the User ID being entered is NUSER. 

 
4. Enter your initials in the Initials field. Your initials will be displayed on the main Abstract 

Plus window to indicate when you are logged in to the application, and will be automatically 
recorded in the Abstracted By field when abstracting abstracts.  This information is recorded 
in order to associate abstractors with the abstracts they have generated.  In the example 
shown, the initials entered are NAU. 
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5. Click Add. 

Result: The system adds the new user account to the users list. 

 
6. Click Close. 

Result: The Login window opens. 
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7. Enter your User ID in the User ID field. In the example shown, the User ID of NUSER is 

being entered. 

 
8. Enter the default initial password of Welcome1 in the Password field.   

  

 

When entering your password, asterisks will be displayed rather than your password for 
added security.  Note that passwords are case sensitive. 

9. Click OK 

Result: A Password Update message is issued that lets you know you need to change your 
password.  This occurs upon initial log in only.  When changing your password, you must 
change it to a password that meets the password requirements set by the PCR.   

Welcome1 
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10. Click OK 

Result: The Change User’s Password window opens, displaying your User ID and Old 
Password (which is Welcome1 at this point). 

 
11. Enter a new password in both the New Password and Confirm Password boxes, and click 

OK.  You must type the same new password in both boxes. 

 

Your new password must be between 8 and 20 characters, contain at least one digit and 
one alphabetical character, and must not contain any special characters. 

Result: The Define User’s Security Questions window opens, with your User ID displayed.   
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To complete your initial log in to Abstract Plus, you are required to select three of the 
security questions and answer them.  Your answers to these questions will be used to validate 
your identity if you forget your general user Abstract Plus password.  If you forget your 
password, Abstract Plus will ask you for the answers you provided to your chosen security 
questions, and then allow you to reset your password if the questions are answered correctly.  
If you forget both your password and your answers to your selected security questions, you 
will need to contact the PCR for instructions on how to reset your password. 

12. Select a question from the first drop-down list and enter your answer in the box below the 
question.   

 
13. Continue selecting questions and answering them until each question is answered.   
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14. Once all questions are selected and answers entered, click Submit Questions. 

Result: The Abstract Plus main window opens, with you logged in as a general user. Note 
that your User ID is displayed at the bottom of the window.   
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DEFAULTING FACILITY ID# 
 

To default the Reporting Facility identification number for your facility in Abstract Plus 
follow the below instructions. This procedure only needs to be performed one time after 
initial install of the V15.0 Abstract Plus software.  
 
1. Log into Abstract Plus if not logged in already. 
 
2. Click on Administration.  
 
3. Click on Manage Abstracting Display Type.  
 
4. Enter Admin (case sensitive) in Password box and click OK.  
 
5. Click on Display Fields tab.  
 
6. Scroll down under Assigned Fields for Display Type (on the right of the screen) until you 
see Reporting Facility (540).  
 
7. Click on Reporting Facility (it will be highlighted).  
 
8. Click on the Properties button.  
 
9. Enter your 10-digit CoC number under Field Default Value including the leading zeros. If 
you do not know your 10-digit CoC number, see list at the end of this procedure.  
 
10. Click on OK. The number you entered will then display in parenthesis beside the 
Reporting Facility field.  
 
11. Click on Save (upper right).  
 
12. Click on Close.  
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Listing of CoC numbers for Abstract Plus facilities: 

Facility CoC 10-digit # 
Abington Memorial Hospital 0006230010 
Ameripath CT  0006237007 
Ameripath Ohio  0006237002 
Ameripath Michigan  0006237016 
Berwick Hospital Center  0006230150 
Bucktail Medical Center  0006232880 
Carlisle Regional Medical Center  0006230340 
Corry Memorial Hospital  0006230510 
Edgewood Surgical Hospital  0010000508 
Ellwood City Hospital  0006230720 
Endless Mountain Health Sys  0010001152 
Fulton County Med Ctr  0006231325 
Geisinger Bloomsburg Hospital 0006230170 
Geisinger Medical Center 0006230550 
Geisinger Wyoming Valley Medical Center 0006232725 
Gnaden Huetten Memorial Hospital 0006231205 
Greater Harrisburg Cancer Center  0010000140 
Grove City Medical Center  0006230855 
Guthrie Towanda Memorial Hospital  0006233260 
Hanover Hospital  0006230880 
Heart of Lancaster Reg Med Ctr  0006239183 
Highlands Hospital  0006230500 
Holy Spirit Hospital  0006230297 
J C Blair Memorial Hospital  0006231000 
Jameson Memorial Hospital 0010000108 
Jeanes Hospital  0006231930 
Jersey Shore Hospital  0006231020 
Lancaster Reg Med Ctr  0006231140 
Lebanon Valley Cancer Center  0010000141 
Lehigh Valley Hosp-Hazleton 0006230950 
Lock Haven Hospital  0006231270 
Lower Bucks Hospital  0006230205 
Memorial Hospital York  0006233549 
Nason Hospital  0006232920 
Ohio Valley Gen Hospital  0006231340 
Palmerton Hospital 0006231620 
Penn Highlands Brookville  0006230210 
Penn Highlands Clearfield  0006230430 
Penn Highlands Dubois 0006230620 
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Facility CoC 10-digit # 
Penn Highlands Elk  0006232960 
Punxsutawney Area Hospital  0006232810 
Schuylkill Med Ctr-S Jackson St  0006232800 
Sharon Regional Health System 0006233120 
Soldiers & Sailors Mem Hospital  0006233380 
Somerset Hospital Center for Health  0006233140 
Southwest Regional Med Ctr  0006233370 
St Christopher’s Hospital  0006232210 
St Joseph’s Hospital -Phila  0006232220 
Sunbury Community Hospital  0006233200 
Surgical Institute of Reading  0010000848 
Titusville Hospital  0006233240 
Troy Community Hospital  0006231409 
Tyrone Hospital 0006233267 
Warren General Hospital  0006233290 
Washington Hospital  0006233320 
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ROUTINE LOG-IN 
 

After installation and initial log in to Abstract Plus, you will have a User ID and password for 
routine log in to your Abstract Plus general user account.   

For routine log in to Abstract Plus, complete these steps: 

1. To launch the program, from the Start menu, select All Programs, Registry Plus, Abstract 
Plus, and then Abstract Plus or if you have created an icon on your desk top, double click on 
the icon. 

Result: The Login window opens. 

 
2. Enter your User ID in the User ID box. In the example shown, the User ID being entered is 

NUSER. 

 
3. Enter your password in the Password box, and Click OK. 

 

When entering your password, asterisks will be displayed rather than your password for 
added security.  Note that passwords are case sensitive. 
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Result: The Abstract Plus main window opens, with you logged in as a general user. Note 
that your User ID is displayed at the bottom of the window.  
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CHANGING YOUR USER PASSWORD 
 

For security purposes, you will be prompted to change your user password every 60 days.  
Abstract Plus will not allow the same password to be used during the past twelve password 
changes. 
 
To change your Abstractor user password, complete these steps: 

1. Open the Change User’s Password window.  This may be done in two ways: 

a. From Options Menu, select Change Password.  

 
b. When logging in to Abstract Plus, enter your User ID, tab or click into the Password 

box, and then click Change Password on the Login window.  

 
Result: The Change User’s Password window opens, with your User ID displayed. 

 
2. Enter your Current Password in Old Password box. 
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3. Enter a New Password in New Password box, which meets the password requirements.   

 

 

Your new password must be between 8 and 20 characters, contain at least one digit and 
one alphabetical character, and must not contain any special characters. 

4. Re-enter your New Password in the Confirm Password box. 

 
5. Click OK to change your password. 

Result: Your password is changed, and the Abstract Plus main window is opened. 

Possible Errors when Changing Your Password 

There are three possible errors you may receive when attempting to change your password: 

1. Old password is incorrect. You must correctly enter your old password in order to 
successfully change it. Click OK, and then correctly re-enter your old password. 

 
2. New passwords do not match.  The new password entered into the New Password and 

Confirm Password boxes must match exactly. Click OK, and then correctly re-enter your 
new password in the New and Confirm password boxes. 
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3. New password does not meet specified password requirements.  Your new password must 

meet the password requirements specified by the PCR.  Click OK, and then re-enter a new 
password that meets the stated password requirements. 

 
 
4. Password previously used.  Abstract Plus will not allow the same password to be used 

during the past twelve password changes. 
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RESETTING A FORGOTTEN PASSWORD 
 
In the event that you should forget your password, Abstract Plus has a security challenge question 
feature that will allow you to reset your own password without having to contact the PCR. The 
security challenge question feature enables you to securely reset your password by answering a 
specified number of the security questions that you selected and answered upon initial login to 
Abstract Plus.   
 
Your answers to these questions are used to validate your identity; Abstract Plus will ask you for 
the answers you provided to your chosen security questions, and then allow you to reset your 
password if the questions are answered correctly.  If you forget both your password and your 
answers to your security questions, you will need to contact the PCR for instructions on how to 
reset your password. 
 
To reset your password if you have forgotten it, complete these steps: 

1. When logging in to Abstract Plus, enter your User ID, tab or click into the Password box, and 
then click Forgot Password on the Login window.  

 
Result: The Reset User’s Password window opens, with your User ID displayed, as well as 
the security questions. 
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2. Enter the answer to each displayed question with the same answer you provided upon initial 

login to Abstract Plus. 

 
3. Click Validate Questions once all questions are answered. 

Result: The Reset User’s Password window opens, with your User ID displayed.  
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4. Enter a New Password in both the New and Confirm password boxes, and then click Reset 

Password. 

 
Result: The Forgot Password window opens, with your User ID displayed. 
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5. Enter your New Password in Password box, and click OK.  

Result: The Abstract Plus main window opens, with you logged in as a general user. Your 
password has been successfully set to the new password you have specified. 
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UPDATING PERSONAL SECURITY QUESTIONS 
Once you are logged in to Abstract Plus, you can update your selected security questions and/or 
answers at any point. For example, if you selected the security question of “How many children 
do you have?” and you just had a new child enter your family, you can update your answer to this 
question.  

To update your security questions and/or answers, complete these steps: 

1. From Options Menu, select Update Security Questions. 

 
Result: The Update User’s Security Questions window opens, with your User ID 
displayed, as well as the current security questions and answers which you have specified. 
For added security asterisks are displayed rather than your answers to the questions. 

 
2. You can select new questions and answer them, or supply new answers to your previously 

selected questions. When you have completed your changes, click Submit Questions. 
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Result: You are returned to the Abstract Plus main window, with your changes saved for 
future use. 
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OPENING ABSTRACT PLUS 
 

1.   Double click on the Abstract Plus icon or from the Start menu, select All Programs, Registry 
Plus, Abstract Plus, and then Abstract Plus. 

Result: The Login window opens. 

 
2.    Enter your User ID in the User ID box. In the example shown, the User ID being entered is 

NUSER. 

 
3. Enter your password in the Password box, and Click OK. 

 

When entering your password, asterisks will be displayed rather than your password for 
added security. Note that passwords are case sensitive. 
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Result: The Abstract Plus main window opens, with you logged in as a general user. Note 
that your User ID is displayed at the bottom of the window.  
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OPENING A NEW ABSTRACT 
To create a new abstract, complete these steps: 

1. Open the Abstract Plus Abstracting window. This can be done in three ways: 

a. Click on the File menu, and select New Abstract. 

 

b. Click the New icon on the tool bar . 

c. Use the keystroke Ctrl+N.  

Result:  The Abstract Plus Abstracting Window opens. 
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THE ABSTRACT PLUS ABSTRACTING WINDOW 
Abstract Plus has an extremely user-friendly abstracting interface. Direct grid entry of coded 
values and quick select options for pull-down menus allow for an easy, streamlined abstracting 
experience, as well as easier viewing of text fields, online help, and edit errors. 

The Abstract Plus Abstracting window is divided into two main sections: a data entry grid for 
coded values on the left, and a data entry grid for text fields on the right.  When you left-click and 
hold your mouse on the vertical divider bar in the center of the window, a splitter is highlighted 
which you can drag to the left or right to resize the view of codes or text fields, and the 
application remembers your last placement of the divider bar. You can vertically scroll the view 
of coded values and text fields independently to easily and concurrently view codes and 
associated text. 

 
The basic process of generating and updating an abstract is as follows:  
 
i. Create the abstract with the patient’s identifiers, such as name and social security number 

and save. After you create an abstract, you can save it at any time and return to your work 
at a later time.  

ii. Enter codes and text in the in the data entry fields. Save the abstract to retain the 
information you have entered. 

Edit Error 
Count  

Easy, Direct 
Access to Text 
Fields 

Can Resize 
Panes 

Right-click Any 
Field for Help 
and Edit Errors 

Direct 
Grid 
Entry 

Section 
Headers 

Completion 
Status 
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iii. Correct errors. Each time you open or save the abstract, Abstract Plus automatically edits 
the entered information for accuracy and completeness using the edit set and required 
fields chosen by the PCR. 

iv. After you have entered all your data and corrected all errors, the system saves your new 
abstract as complete---you will see the edits error count and completion status indicators 
at the bottom of the abstracting window turn from red to green, indicating that the 
abstract is complete. 

The Abstractor uses the following abstracting features of the abstracting window to enter 
information regarding the patient and tumor being abstracted: 
 

a. Many data items offer code selection from drop-down lists.  In addition, the drop-
down lists feature an auto-complete, find-as-you-type function that allows the user 
to type in the first letter, or first few letters, of the desired code label, and the 
application auto-selects the first item in the list beginning with that letter.  In the 
example shown below, an A has been typed into the Race 1 field, and the application 
auto-selects the value of American Indian, Aleutian, or Eskimo: 

 
 

 

If you begin typing in the data item, but find you need to revise what you 
have typed, press the backspace key to delete what you have already 
entered, and start typing again. This enables the find-as-you-type feature to 
automatically find your revised entry. 

b. Prompt messages may be associated with each data item, so that when the abstractor 
clicks into the field, a pop-up box comes up with a message or instructions about 
abstracting that field: 

 
 

c. When entering text, a progress bar is displayed below each text field indicating how 
much space is left so that you can properly prioritize the information you are 
entering:  
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d. Keyboard and mouse alternatives are available for every function in the software.  
Note that Keystroke options are displayed on menus for all menu items, and 
Appendix A of this manual contains a listing of standard Abstract Plus keyboard 
shortcuts to functions. 

e. All-new right-click functions for individual data items, including access to field 
context help, edits error information, field messages, and a function to clear all 
Collaborative Stage fields: 

 
 

f. Color-coded edits error count and abstract completion status information is 
clearly displayed to the user at the bottom of the abstracting window, and changes 
from red to green upon completion of the abstract: 

Incomplete abstract containing edit errors: 
 

 
 
Complete abstract containing no edit errors: 
 

 
 

g. Once saved, each abstract is assigned an unique Abstract Reference ID (or 
AbsRefID), displayed in the upper left-hand corner of the data entry area of 
abstracting window, as well as in the title bar of the application along with the patient 
name: 

August 2015  40 



 
Pennsylvania Cancer Registry (PCR)                             Abstract Plus V15.0 User’s Guide 
 

 
 

h. Abstracts can be held to prevent export. The Held check box allows an abstractor 
to prevent a case from being exported even if it is considered complete by the system. 
This can be used if, for example, the abstractor is searching for additional 
information to be included before the abstract is exported.  If checked, the abstract 
will not be exported, regardless of Completion Status: 
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ABSTRACTING AND DERIVING COLLABORATIVE STAGING 
FIELDS 

Abstract Plus has some special features to facilitate the abstraction of Collaborative Staging (CS) 
input fields, in particular for the Site-specific Factors (SSFs).  

Abstracting CS Input Fields 

Once the fields of primary site and histology have been entered, each CS input data item has a 
special site-specific look-up associated with it that is accessed by clicking the magnifying glass 
icon to the left of the field or pressing F4. 

Required PCR CS SSFs:  Abstract Plus does not flag what CS SSFs are required by the 
PCR.  Refer to Appendix J of the PCR 2015 Manual for the list of required PCR CS SSFs.  
If the CS SSF is not required by the PCR, 988 must be entered in Abstract Plus. 

 

 

Abstracting CS SSFs 

Abstract Plus allows for automatic defaulting of CS SSFs and running of edits to identify required 
CS fields, automatic filling in of CS Version fields, as well as the wiping out of CS input fields 
for cases diagnosed 2003 and earlier. 

For the filling of the CS Version fields, once the Abstractor enters Primary Site, Histology, 
DxDate and Behavior (in no particular expected order), the fields of CS Version Input Current 
and CS Version Input Original are both automatically filled when the Abstractor enters any CS 
input field.  CS Version Derived is filled when you derive the CS derived fields.   

Once entered, a check on primary site and histology is run to ascertain whether or not SSF25 is 
required for schema identification.  Upon checking the primary site and histology entered: 

1. If SSF25 is required for the primary site and histology entered: 
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a. The SSF25 look-up window for the entered schema will open so that you can select a 
value for SSF25.  

b. Once you have entered SSF25, automatic defaulting and disabling of SSFs that are 
undefined for the entered schema will occur, and the edits will be run automatically.  
This will enable you to clearly discern what SSFs are not required, and which SSFs 
are required.  The automatic defaulting will delineate what SSFs are not defined for 
the identified schema, and the automatic running of edits will delineate what SSFs 
are required. 

 

If the primary site and histology initially entered are revised to result in a different 
schema, you will be offered the option of clearing all CS input fields and re-coding 
CS for the abstract. Regardless of whether you clear all values and re-code CS, or 
keep existing values and modify the codes, the above SSF defaulting routine will 
run again for the newly entered schema. 

2. If SSF25 is not required for the primary site and histology entered: 
a. SSF25 will be automatically defaulted and disabled. 
b. Automatic defaulting and disabling of other SSFs that are undefined for the entered 

schema will occur, and the edits will be run automatically.  This will enable you to 
clearly discern what SSFs are not required, and which SSFs are required.  The 
automatic defaulting will delineate what SSFs are not defined for the identified 
schema, and the automatic running of edits will delineate what SSFs are required. 

Calculating Derived CS Fields 

To derive the derived CS fields, once appropriate CS input fields have been entered, place the 
cursor into any of the derived fields and click the calculator icon to the left of the field, or press 
F5. 

 

CS Fields and Tumors Diagnosed 2003 and Earlier 

One further helpful feature is that upon entry of a Date of Diagnosis of 2003 and earlier, you will 
be offered the option of clearing all CS fields. 
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The Clear Collaborative Staging Values window opens automatically upon 
entry of a diagnosis year of less than 2004.  However, you can clear 
Collaborative Staging fields at any time by using the right-click function 
of Clear Collaborative Stage Fields or pressing F9. 
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ENTERING DATES 
 
As of the NAACCR version 12 record layout, all dates are in the YYYYMMDD format.  Because 
the NAACCR standards are so tightly integrated with the Abstract Plus program, dates are 
entered in the YYYY/MM/DD format in Abstract Plus.  
 
The Abstractor will enter dates in the new YYYYMMDD format as follows: 
 
YYYYMMDD – when complete date is known and valid 
YYYYMM – when year and month are known and valid, and day is unknown 
YYYY – when year is known and valid, and month and day are unknown 
Blank – when no known date applies 

 

Abstract Plus has a date field entry mask on all date fields that already has the 
slashes in it.  Although the application allows you to type the slashes and dashes 
when entering dates fields, you can save keystrokes by only typing the 8 
characters of the date.  For example for the date of July 1, 2015, the date can be 
entered as 20150701. 
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ENTERING INFORMATION INTO TEXT FIELDS 
 
The NAACCR Volume II Data Dictionary defines text documentation as an essential component 
of a complete electronic abstract.  Text information is utilized for quality control and special 
studies, and is needed to justify coded values and to document supplemental information not 
transmitted within coded values. High-quality text documentation facilitates consolidation of 
information from multiple reporting sources at the central registry. 
 
The text field must contain a description that has been entered by the abstractor independently 
from the code(s). Information documenting the disease process and treatments provided should be 
entered manually from the medical record. It is best practice to abstract all available text 
information prior to entering codes for any of the coded cancer identification of treatment data 
items. 
 
In Abstract Plus, the various text fields are presented within the data entry grid on the right side 
of the Abstracting Window.   
  
You can scroll up and down in the text entry grid separate from the data entry grid on the left, 
facilitating the concurrent viewing of text and codes.  Note that when entering text, a helpful 
progress bar is displayed below each text field that indicates how much space is left so that you 
can properly prioritize the information you are entering. 

 

 

Line returns are not allowed in Abstract Plus text fields---pressing Enter will 
move the cursor to the next text field in the text entry grid. 
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SAVING AN ABSTRACT 
Once you have entered information into an abstract, it is a good idea to save your work often.  To 
save your work, complete these steps: 

1. Saving an abstract can be done in three ways: 

a. Click on the File menu, and select Save Abstract. 

 

b. Click the Save icon on the tool bar . 

c. Use the keystroke Ctrl+S.  

Results:   

1)  The information entered thus far for the abstract is saved to the database, and  

2)  edits will run  

3)  The Edit Set Results window opens, and displays information about any edit errors the 
abstract may contain. 
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4) Once saved, each abstract is assigned an unique Abstract Reference ID (or AbsRefID), 
displayed in the upper left-hand corner of the data entry area of abstracting window, as well 
as in the title bar of the application along with the patient name: 

 
5) The EDITS Error Count and Abstract Completion status indicators reflect the current edit 
error count and completion status of the abstract.  If there are any errors within the abstract, 
both of these indicators will display in red.  In the example shown, the abstract contains 33 
edit errors and as a result, is deemed incomplete.  
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CORRECTING EDIT ERRORS 
For any abstract you can run edits and view edit errors by saving the abstract, clicking 
the EDITS button on the toolbar, or pressing F8. 
 
Each time an abstract is opened or saved; Abstract Plus automatically edits the entered 
information for accuracy and completeness using the edit set and required fields chosen 
by the PCR.   
 

 

You must resolve all edit errors and fill in all critical (required) fields in 
order to complete the abstract. 

Abstract Plus has edit error display features that greatly facilitate the error resolution process.  
Editing features include: 

a. The edit set being run on the abstract is clearly displayed at the top of the abstracting 
window.  The edit set being applied is named PA A+: 

 
b. When edits are run, the Edit Set Results window automatically opens and displays the full 

information for any edit errors that exist, or lets you know that there are no errors.  The Edit 
Set Results window lists the total number of edit errors for the abstract, missing critical 
(required) fields, and the edit errors.  For each edit error, the failed edit name, error message, 
and fields involved in the edit are listed.  Using the information listed in the Edit Set Results 
window to help you resolve the edit errors, you can click on a link to a field to move to it in 
the data entry grid and make corrections: 
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When greater detail regarding the edit is required to resolve the edit error, click on the Edit 
Description link, which expands to display the edit description; once opened, you can click 
anywhere to close the edit description: 

Links to 
fields in data 
entry grid 
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c. Edit errors can be viewed for the entire abstract, or just for individual fields.  You can view 

all edit errors for the abstract as shown above by clicking on the EDITS icon on the toolbar 
, right-clicking and selecting Run Edits, or by pressing F8.  

Or you can choose to view edit errors by individual data field by right-clicking and 
selecting Edits Information, or by clicking F2.  In the example shown, the edit errors for the 
individual field of Date of Diagnosis are being viewed: 

Click Edit Description link 
to open description; click 
anywhere to close 
description 
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When viewing edit errors for an individual field, you can switch from the individual data 

field edit errors view to the all edit errors view by clicking on the Show All  
button. 

 

You can make corrections to fields by clicking on the links to the fields in the 
Edit Set Results windows.  To see your corrections reflected, click the Refresh 

 button. 
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EXPORTING ABSTRACTS 
1. Abstracts can be exported in three ways: 

a. Click on the File menu, and select Export Abstracts. 

 

b. Click the Export icon on the tool bar . 

c. Use the keystroke Ctrl+M.  

Result:  The Export Abstracts window opens, and presents you with different options for 
exporting abstracts. 
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The Mark Exported Abstracts as Exported and Export Only Un-Exported 
Abstracts To Date options are selected by default and, should not be changed as 
these options will prevent re-export of previously exported abstracts, thus 
preventing reporting of duplicate abstracts to the PCR. 

 
2. Click A Type Record and hit Select. 

Result: The system displays the number of abstracts that meet the export criteria. 

 
3. Click OK. 

If you would like to see a list of the records to be exported, click on Preview. 

 
4. Click Export. 

Result: The Save As window opens. 
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5. Enter your PCR four-digit Hospital ID#, the month/year and your initials with no spaces (for 
example:  1509jan15emr) in the File name box and click Save.   
 

Result: The system saves the abstracts into a text file and lets you preview a report that you 
can print. 
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The PCR does not require a copy of this list.  Based on your preference, you can either 
print the listing or save it as an electronic file following the below instructions.  If you prefer 
to not save the listing, skip to #6. 

 
• Click on the Save and select Text File. 

 
• The Export Settings box will appear (All will be defaulted for page range).   

 
• Click on OK.   

 
• Tab down to File name:   

 
• Enter your PCR four-digit Hospital ID#, the month/year and the word list with no spaces 

(for example: 1509jan15list). 
 

• Click on Save. 
 

6. Close the report preview and return to the Export Abstracts window. 

 

7. Click close to exit the Export Abstracts window. 
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EXITING ABSTRACT PLUS AND USING THE BACKUP OPTION 
When logging off and exiting Abstract Plus, the application will prompt you to back up the 
current abstract database. 

To log off, exit Abstract Plus and use the database backup option, complete these steps: 

1. Exit Abstract Plus.  This can be done in three ways: 

a. Click on the File menu, and select Exit. 

 
b. Use the keystroke Alt+F4.  

c. Click the X in upper right corner of screen. 

  
Result: The Exit Program window opens, and asks if you are sure you want to exit the 
program. 

 
2. Click Yes. 

Result: The Backup Database window opens, and asks if you would like to backup your 
Abstract Plus abstracts database (ABSPLUS.MDB). 
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Although you can choose not to backup your database, it is highly 
recommended that you backup your database after finishing an abstracting 
session during which changes were made (abstracts were added, updated, or 
deleted). Note that the Backup and Restore Database menu options are not 
available when using SQL Server database. 

3. Click Yes.   
Result:  The Abstract Plus Database Backup window opens with defaults set. 

 
4. To change the default path, navigate to and identify the location on your computer or network 

where you would like to save your backup file by clicking the Folder icon . 

Result:  The Browse for Folder window opens. 

 

August 2015  58 



 
Pennsylvania Cancer Registry (PCR)                             Abstract Plus V15.0 User’s Guide 
 

 

The default location for saving backup files is C:\RegPlus\AbstractPlus\MDBS\Backup. 
You may navigate to a different location if you so choose. 

5. To accept the default location for saving the backup, click OK. 

6. Click Save to create the backup (enter a password-optional). 

 
 

 

If you choose to password-protect your backup file, the encrypted zip file 
cannot be restored without the specified password. It is very important that 
you remember this password! 

Result: The backup is saved in the zip file, and a confirmation window opens.   

  
7. Click OK. 
       Result:  The Abstract Plus application closes. 
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RE-EXPORTING PROCEDURE 
1.   Abstracts can be re-exported in three ways: 

a. Click on the File menu, and select Export Abstracts. 

 

b. Click the Export icon on the tool bar . 

c. Use the keystroke Ctrl+M.  

Result:  The Export Abstracts window opens, and presents you with different options for 
exporting abstracts. 
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The Mark Exported Abstracts as Exported and Export Only Un-Exported 
Abstracts To Date options are selected by default and, should not be changed as 
these options will prevent re-export of previously exported abstracts, thus 
preventing reporting of duplicate abstracts to the PCR. 

 
2. Select A Type Record and then select the export option Export by Date Previously 

Exported.  Enter a date range to export previously exported, completed abstracts by the 
date they were previously exported. 

 
3. Click on Select. 

 

Result: The system displays the number of abstracts that meet the export criteria. 

 

 
 

4. Click Export. 

Result: The Save As window opens. 

 
 

5. Enter your PCR four-digit Hospital ID#, the month/year and your initials with no spaces (for 
example:  1509jan15emr) in the File name box and click Save.   
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Result: The system saves the abstracts into a text file and lets you preview a report that you 
can print. 

 
The PCR does not require a copy of this list.  Based on your preference, you can either 
print the listing or save it as an electronic file following the below instructions.  If you prefer 
to not save the listing, skip to #6. 

 
• Click on the Save and select Text File. 

 
• The Export Settings box will appear (All will be defaulted for page range).   

 
• Click on OK.   

 
• Tab down to File name:   

 
• Enter your PCR four-digit Hospital ID#, the month/year and the word list with no spaces 

(for example: 1509jan15list). 
 

• Click on Save. 
 

6. Close the report preview and return to the Export Abstracts window. 

7. Click close to exit the Export Abstracts window. 
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DELETING ABSTRACTS 
 
Abstract Plus allows you to delete abstracts from the abstract database. This feature should be 
used with caution, as abstracts are permanently deleted from the database.   

To delete an abstract, complete these steps: 

1. Abstracts can be deleted in two ways: 

a. Click on the Utilities menu, and select Delete Abstract(s).  

 
b. Use the keystroke Alt+P  

Result: The Delete Abstracts window opens.   

 
2. Abstracts to be deleted can be searched for via various search criteria: patient name, 

Abstractor’s initials, Abstract Reference ID, Reporting Facility, and export date. 

3. Enter your search criteria, and click Query. In the example shown, the abstract for the patient 
named John Doe is being searched for and deleted, so a D is entered in the patient Last Name 
box. 

Result: Abstracts that match the specified search criteria are displayed in the lower portion of 
the window. Note that all abstracts listed are selected for deletion.   In the example shown, all 
patient abstracts with the last name beginning with D are displayed and selected for deletion. 
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4. To select an individual abstract for deletion from the displayed list, click Select/Deselect All. 

Result: All abstracts in the window are deselected. 

5. Select individual abstracts for deletion by checking the Delete Case check box for the 
abstract(s), and clicking Delete. 

 
Result: The system verifies that you would like to delete the selected abstract(s), and creates 
a backup database. 
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6. Click Yes. 

Result: The system lets you know that the abstract has been deleted. 

 
7. Click OK. 

Result: You are returned to the Delete Abstracts window, where the abstract(s) has been 
deleted from the list. 

 
8. When you have finished deleting abstracts click Close to close the Delete Abstracts window. 
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SEARCH FOR AND OPENING AN EXISITING ABSTRACT 
To find and open an existing abstract, complete these steps: 

1. Existing abstracts can be searched for and opened in three ways: 

a. Click on the File menu, and select Open/Find Abstract. 

 

b. Click the Open icon on the tool bar . 

c. Use the keystroke Ctrl+O.  

Result:  The Open/Find Abstract window opens. 

August 2015  66 



 
Pennsylvania Cancer Registry (PCR)                             Abstract Plus V15.0 User’s Guide 
 

 
The Open/Find Abstract window has two main sections.  The patient query area is located 
in the upper portion of window, and the lower portion of the window displays the query 
results as a list of abstracts from which the abstract of interest can be opened.  Abstracts listed 
can be queried by any combination of patient first and last names, medical record number, 
social security number, or date of birth, reporting hospital, or Abstract Reference ID.  In 
addition, abstracts can be queried for by abstract completion status by clicking on the 
appropriate search option at the top of the window. 
 

 

If you click the Incomplete Abstracts Only search criteria option, only abstracts for which 
abstraction has not yet been completed will be displayed; this is very helpful for identifying 
abstracts yet to be completed. 

  

The abstract list window includes these fields and column headings: 

Columns Description 

Name Name of Patient (Last, First) 

Abstract ID A system-generated number identifying the abstract 

Date of Birth Patient’s date of birth 

Social Security # Patient’s social security number 

Sex Patient’s sex 

Query 
Criteria 

List of Abstracts 
to be Opened 
(Resulting from 
Search) 
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Columns Description 

Acc Num Hosp Hospital accession number reported by the audited facility for the 
reported tumor 

Seq Num Hosp Sequence number hospital reported by the audited facility for the 
reported tumor 

Date 1st Contact Date of 1st contact reported by the audited facility for the reported 
tumor 

Diagnosis Date Diagnosis date of the reported tumor 

Primary Site ICD-O-3 topography code describing the location of the reported 
tumor 

Reporting Hospital COC code for the reporting facility that reported the tumor 

Laterality Code for the side of a paired organ, or the side of the body on which 
the reported tumor originated 

Hist/Beh ICDO3 ICD-O-3 histology and behavior codes for the reported tumor 

Medical Record # Patient’s medical record number 

Date Last Contact Date last contact reported by the audited facility for the reported 
tumor 

Vital Status Patient’s vital status 

Abstract Status The status of the reabstract---incomplete, complete, or held 
 

 

The order of the columns on the abstract list window may be modified.  Simply 
left-click and hold on the column header, and slide the column to the desired 
position in the column viewing order. 

2. Query for a patient on the list of tumors to be opened. Enter the first letter of the patient’s 
last name in the Last Name search criteria box on the Open/Find Abstract window, and 
click Query. You can also use any of the other available search criteria to search upon. In the 
example shown, the abstract being searched for is for a patient named John Doe, so a D is 
entered in the Last Name search criteria box.  
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Result:  The Open/Find Abstract window presents the results of the query, and displays any 
potential matches in the tumor list window. 

 
3. From the abstracts listed, locate the abstract of interest open the abstract, either by double-

clicking the row for the abstract, or select the row for the abstract and click Select. 

Result:  The Abstract Plus Abstracting window opens so that you can modify the abstract 
that has just been opened.   
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COPYING AN ABSTRACT 
 
The copy feature is especially helpful for the reporting of patients with multiple primaries.  
Simply open the abstract for the first primary for the patient, copy the abstract, and then enter the 
tumor and treatment information for the subsequent primary tumor.   

To copy an abstract, complete these steps: 

1. Make sure that you have the abstract to be copied open in the abstracting window. 

2. Abstracts can be copied in three ways: 

a. Click on the File menu, and select Copy Abstract. 

 

b. Click the Copy icon on the tool bar . 

c. Use the keystroke Ctrl+I.  

Result:  The abstract is copied to a new Abstract Reference ID. Note that only the patient 
demographics from the original abstract are copied into the new abstract, so that you 
need only enter information regarding the tumor being abstracted.  Edits are run, and the Edit 
error count and completion status indicators will indicate that there are errors (missing fields) 
for the abstract and that the abstract is incomplete. 
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3. Once you have finished work on the newly copied abstract, save your work, and close the 

abstract. 
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PRINTING ABSTRACTS 
 
You can print any individual abstract that is open, or you can select one or more abstracts from 
your local database and print them. You can also choose to print the abstracts to a text file instead 
of sending them directly to a printer. 

Printing an Open Abstract 

To print an individual abstract that is open, complete these steps: 

1. Open abstract can be printed in three ways: 

a. Click on the File menu, and select Print Current Abstract. 

 

b. Click the Print icon on the tool bar . 

c. Use the keystroke Ctrl+P.  

Result: The Abstract Plus Report Viewer window opens with a print-preview of the abstract 
to be printed.  Note that for the majority of fields, the coded value and the label are printed.  
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2. Click Print or Save to print or save the abstract in the format of your choice.  

3. When you are done viewing/printing the abstract, click Close. 

Printing a Range of Abstracts  

To print a range of abstracts, complete these steps: 

1. Printing a range of abstracts can be done in two ways: 

a. Click on the File menu, and select Print Range of Abstracts. 
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b. Use the keystroke Ctrl+R.  

Result: The Print Abstracts window opens. 

 
1. Enter the abstract selection criteria for the range of abstracts that you would like to print. You 

can select the only un-exported Abstracts To Date or All Abstracts in Database options,  or 
you can select abstracts by date previously exported, date created, Facility or Project ID, 
Abstractor ID or AbsRefID. In the example shown the Select the All Abstracts in Database 
printing option is checked. 

2. Click Select. 

Result: The system displays the number of abstracts that meet the selected criteria at the 
bottom of the window. 
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3. Click Print Preview. 

Result: The Report Viewer window opens with the selected abstracts formatted for printing.  
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4. When you are done viewing the report, click Print to print the report, Save to save the report. 

5. Click Close to close the report. 

6. Close the Print Abstracts window. 
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REPORTS 
 

The abstracting features of Abstract Plus are supported by a few standard, easy-to-understand 
reports that can help facilitate and track abstracting activities.  The available abstract reports are 
described in the table below. 

Report Description 

Accession Register  Includes a line listing of all abstracts in the database, sorted by 
reporting hospital and accession number 

Patient Index Includes a line listing of all abstracts in the database, sorted 
alphabetically by name 

Selected Cases Line listing report which includes abstracts based on user-
specified criteria 

Status Report (Count of 
Cases) Summary…  

Includes the total number of complete and incomplete abstracts 
by export status within a user-specified date range 

Completion Status of 
Abstracts by month  

Includes abstract completion status by year and month of Date 
of Adm/1st Contact within a user-specified date range  

Opening Reports 

To open any of the various abstract reports, complete these steps: 

1. All abstract reports can be opened in two ways: 

a. Click on the Reports menu, and select the report of interest. 

b. Use the appropriate keystroke designated on the Reports menu to open the report of 
interest.  For example, to open the Accession Register Report, use the keystroke 
Alt+Shift+A.  

Result: The report of interest opens in the Abstract Plus Report Viewer window. 

Viewing Reports – The Report Viewer Window 
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The Abstract Plus Report Viewer window is divided into two main sections: a window in which 
to view reports on the left, and a pane for viewing report thumbnails on the right.  When you left-
click and hold your mouse on the vertical divider bar in the center of the window, a splitter 
appears which you can drag to the left or right to resize the view report and thumbnails views.   

The Main Toolbar 

 
The Report Viewer Main Toolbar includes icons to print and save the report being viewed, as 
well as modify the current view of the report.  The following table describes the function of each 
of the icons on the Main Toolbar, as well as listing keystroke equivalents where available for 
each function. 

Icon Keystroke Function 

 Ctrl+P Print the report being viewed; opens the print dialog window 

 Ctrl+O Save the report being viewed to various file formats 

 Ctrl+Shift+S Change report page setup: size, orientation and margins 

Page 
Navigation 
Controls 

Can 
Resize 
Panes 

Main 
Toolbar 

Page View 
Controls 

Report 
Being 
Run 

Report 
Thumbnails 

Open 
Search 
Toolbar 
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 Ctrl+B 

Show/hide the tree of bookmarks of the report being viewed; 
bookmarks are displayed by default---if there are no bookmarks 
in the report the Report Viewer will automatically hide the tree 
of bookmarks 

 Ctrl+T Show/hide the thumbnail view of reports in the pane on the right 

 Ctrl+F Search; Open the Search Toolbar 

 F2 View the report in full screen mode 

 F3 View the report one page at-a-time 

 F4 View the report 2 pages at-a-time 

 No keystroke View multiple pages of the report at-a-time; specify 1x2, 2x3, 
etc. 

 F5 Control page width; when clicked report will enlarge to the page 
width of Report Viewer window 

 No keystroke Close a report  

Page Navigation Controls 

 
Report page navigation controls are located in the lower left-hand corner of the Report Viewer 
window and help you navigate through the various pages of the report being viewed. The 
following table describes the function of each of the page navigation controls. 

Control Function 

 
View the first page of the report being viewed 

 
View the previous page of the report being viewed 

 
Lists the page number of the current page of the report being viewed 

 
View the next page of the report being viewed 

 
View the last page of the report being viewed 
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The Search Toolbar 
The search panel is used to search for specific text within the report.  To access feature, click the 

binocular icon  on the main toolbar. 

 
When opened, the Search Toolbar is located in the lower left-hand corner of the Report Viewer 
window directly over the Page Navigation controls. The following table describes the function of 
each of the Search toolbar icons. 

Icon Function 

 
Closes the Search Toolbar 

 
Enter the term being searched for in the Find What box 

 

When clicked, searches the report and finds the next 
occurrence of the search term entered in the Find What 
box 

 
When checked, the search is repeated with case of the 
search term considered 

 
When checked, the search is repeated with only whole 
words of the search term considered 

Page View Controls 

 
Report page view controls are located in the lower right-hand corner of the Report Viewer 
window, and include icons to help you control how many pages of the report to view, as well as 
to zoom in or out on the current report being viewed. The following table describes the function 
of each of the page view controls. 

Control Keystroke Function 

 Shift+F2 Single Page: View the report one page at-a- 
time 

 Shift+F3 Continuous: View the report with all pages 
displayed continuously 

 Shift+F4 
Multiple Pages:  based on the selected 
zoom, all possible pages are displayed to 
fill the viewer window 
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 No keystroke Selected Zoom:  View the report at the 
percent size specified  

Saving Reports 

In order to facilitate the utilization of the information included in the Abstract Plus 
reports, Abstract Plus offers an extensive number of file formats in which the reports can 
be saved.  You can save the reports in different file formats in order to further analyze or 
format the data included differently, or you can save the report as an image file to be 
placed in documents and presentations. 
 
You can save your report in any of the file formats listed under the Save As icon on the 
Main Toolbar of the Report Viewer: 

 

Accession Register Report 

To run the Accession Register report, complete these steps: 
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1. The Accession Register report can be opened in two ways: 

a. Click on the Reports menu, and select Accession Register. 

 
b. Use the keystroke Alt+Shift+A.  

Result: The Accession Register report opens in the Report Viewer window. Notice that the 
accession numbers are displayed in ascending order and grouped by the reporting hospital. 

 
The Accession Register report includes these fields: 

Columns Description 

Rep Hosp COC code for the reporting facility of the abstract 

Acc Num Hosp Hospital Accession Number for the tumor 

Seq Hospital Sequence Number for the tumor  

Name Name of Patient (Last, First) 

Birth Date Patient’s date of birth 

Social Security Patient’s social security number 

Sex Patient’s sex 

Diagnosis Date Diagnosis date of the tumor 
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Columns Description 

Primary Site ICD-O-3 topography code describing the location of the tumor 

Lateral Laterality code for the laterality of the tumor 

Hist/Beh ICDO3 ICD-O-3 histology and behavior codes for the tumor 

Medical Rec Num Patient’s medical record number 

Last Contact Date of Last Contact with the patient 

Abs Ref ID A unique, system-generated number identifying the abstract 

Vital Status Patient’s vital status 

2. When you are done viewing the report, click Print to print the report, Save to save the report, 
or Close to close the report. 

Patient Index Report 

To run the Patient Index report, complete these steps: 

1. The Patient Index report can be opened in two ways: 

a. Click on the Reports menu, and select Patient Index. 

 
b. Use the keystroke Alt+Shift+P.  

Result: The Patient Index report opens in the Report Viewer window. Notice that the 
abstracts are displayed in alphabetic order by the name. 

 

August 2015  84 



 
Pennsylvania Cancer Registry (PCR)                             Abstract Plus V15.0 User’s Guide 
 

The Patient Index report includes these fields: 

Columns Description 

Rep Hosp COC code for the reporting facility of the abstract 

Acc Num Hosp Hospital Accession Number for the tumor 

Seq Hospital Sequence Number for the tumor  

Name Name of Patient (Last, First) 

Birth Date Patient’s date of birth 

Social Security Patient’s social security number 

Sex Patient’s sex 

Diagnosis Date Diagnosis date of the tumor 

Primary Site ICD-O-3 topography code describing the location of the tumor 

Lateral Laterality code for the laterality of the tumor 

Hist/Beh ICDO3 ICD-O-3 histology and behavior codes for the tumor 

Medical Rec Num Patient’s medical record number 

Last Contact Date of Last Contact with the patient 

Abs Ref ID A unique, system-generated number identifying the abstract 

Vital Status Patient’s vital status 

2. When you are done viewing the report, click Print to print the report, Save to save the report, 
or Close to close the report. 

Selected Cases Report 

To run the Selected Cases report, complete these steps: 

1. The Selected Cases report can be opened in two ways: 

a. Click on the Reports menu, and select Selected Cases. 

 
b. Use the keystroke Alt+Shift+S.  
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Result: The system displays a window to enter report criteria. 

 
2. Enter report selection criteria, and click Query.  Available report selection criteria include 

patient last name, first name, medical record number, social security number, and date of 
birth, as well as Abstract Reference ID, reporting hospital, and abstract completion status.  In 
the example shown, the report criterion of Abstract Reference ID numbers 1 to 5 is being 
specified. 

Result: The system displays the cases that meet the entered criteria in the query result 
window. 
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You can further restrict the cases included in the report by un-checking the Report Case 
checkbox in the left-most column of the query window for those cases you would like to 
exclude from the report. 

3. Click Report. 

Result: The Selected Cases report opens in the Report Viewer window. Notice that it 
displays only the cases that fall within the specified range. The system also records and 
displays the SQL statement used to create the report at the top of the report. 
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The Selected Cases report includes these fields: 

Columns Description 

Rep Hosp COC code for the reporting facility of the abstract 

Acc Num Hosp Hospital Accession Number for the tumor 

Seq Hospital Sequence Number for the tumor  

Name Name of Patient (Last, First) 

Birth Date Patient’s date of birth 

Social Security Patient’s social security number 

Sex Patient’s sex 

Diagnosis Date Diagnosis date of the tumor 

Date 1st Contact Date of first contact with the patient 

Primary Site ICD-O-3 topography code describing the location of the tumor 

Lateral Laterality code for the laterality of the tumor 

Hist/Beh ICDO3 ICD-O-3 histology and behavior codes for the tumor 

Medical Rec Num Patient’s medical record number 

Last Contact Date of Last Contact with the patient 

AbsRefID A unique, system-generated number identifying the abstract 

Vital Status Patient’s vital status 

4. When you are done viewing the report, click Print to print the report, Save to save the report, 
or Close to close the report. 

Status Report (Count of Cases) Summary 

To run the Status Report (Count of Cases) Summary report, complete these steps: 

1. Status Report (Count of Cases) Summary report can be opened in two ways: 

a. Click on the Reports menu, and select Status report (Count of Cases) Summary. 

 

August 2015  88 



 
Pennsylvania Cancer Registry (PCR)                             Abstract Plus V15.0 User’s Guide 
 

b. Use the keystroke Alt+Shift+T.  

Result: The system displays a window where you enter a date range, or select all cases in the 
database for the report. 

 
2. Enter the desired date range, or check the Select All Cases in Database check box to include 

all abstracts in the database, and click Preview.  In the example shown all abstracts in the 
database are being included in the report. 

Result: The Status Report (Count of Cases) Summary report opens in the Report Viewer 
window displays the summary information for the abstracts.  

 
The Status Report (Count of Cases) Summary report includes the number of incomplete and 
complete abstracts, stratified by abstract export status. 

3. When you are done viewing the report, click Print to print the report, Save to save the report, 
or Close to close the report. 

Completion Status of Abstracts by Month 

To run the Completion Status of Abstracts by Month report, complete these steps: 

1. The Completion Status of Abstracts by Month report can be opened in two ways: 

a. Click on the Reports menu, and select Completion Status of Abstracts by Month. 
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b. Use the keystroke Alt+Shift+C.  

Result: The system displays a window where you enter a date range, or select all cases in the 
database for the report. 

 
1. Enter the desired date range, or check the Select All Cases in Database check box to include 

all abstracts in the database, and click Preview.  In the example shown all abstracts in the 
database are being included in the report. 

Result: The Completion Status of Abstracts by Month report opens in the Report Viewer 
window displays the summary information for the abstracts.  

 
The Completion Status of Abstracts by Month report includes the number of incomplete and 
complete abstracts, stratified by diagnosis moth or year, depending on the range of dates 
specified. 
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2. When you are done viewing the report, click Print to print the report, Save to save the report, 

or Close to close the report. 

Running Custom Reports 

Abstract Plus offers an all-new custom reports feature.  This feature is being implemented in 
phases.  In the first release custom reports that have been generated by the Abstract Plus 
Development team at CDC can be opened by Abstract Plus users.  The various other custom 
report features, such as being able to generate your own report or modify an existing one, will be 
implemented in future versions of Abstract Plus. 

To open and view a custom report, complete these steps: 

1. The custom report can be opened in two ways: 

a. Click on the Reports menu, and select Run Custom Reports. 

 
b. Use the keystroke Alt+Shift+R.  

Result: The Select the Report you would like to Run window opens. 

 
2. Select the custom report you would like to open and click Open. 

Result: The selected report opens in the Abstract Plus Report viewer window. 
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3. When you are done viewing the report, click Print to print the report, Save to save the report, 

or Close to close the report. 
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USING THE RESTORE OPTION 
In the event that your Abstract Plus abstracts database (ABSPLUS.MDB) is corrupted, if you 
have used the Backup option to backup your database you will be able to restore your database 
using the Restore option.  The Restore option allows you to go back to a file that you saved with 
the same Abstract Plus version on a date when you encountered no problems. This is why it is so 
strongly recommended that you back up your work when exiting the application.  

To use the Restore option to restore your Abstract Plus abstract database to an earlier saved 
backup, complete these steps: 

1. Open the Restore Database window.  This can be done in two ways: 

c. Click on the File menu, and select Restore. 

 
d. Use the keystroke Ctrl+Y.  

Result: The Restore Abstract Plus Database window opens. 

 
2. Navigate to and identify the zipped backup file on your computer or network by clicking the 

Folder icon . 
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Result:  The Select the file you want to restore window opens with a list of backup files 
displayed. 

 
 

 

The default location for saving backup files is 
C:\RegPlus\AbstractPlus3\MDBS\Backup  You may need to navigate to a 
different location if you saved your backup file in a location other than the 
default location. 

3. Select the backup file to which you wish to restore your Abstract Plus abstract database, and 
click Open. 

Result:  You are returned to the Restore Abstract Plus Database window, with the selected 
backup file displayed. 

 
4. If you password protected the selected backup file, enter the password in the password box, 

and click Restore. 
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Result:  The Abstract Plus main window opens, with the selected abstracts backup database 
restored. You may now resume abstracting activities. 
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CHANGING INFORMATION/MODIFICATION RECORDS 
 
A change includes updating or correcting previously submitted information. 
 
Abstract Plus has a feature which allows the user to make a change to a previously submitted 
abstracts and re-submit the abstract as a modification record, therefore, allowing the change to be 
submitted electronically instead of one paper. 
 
The change procedure insures the most accurate information is available to users of PCR data by 
enabling reporting facilities to provide updated or corrected information after a record has been 
accessioned by the PCR.   
 
How to Change Information 
 

1. To find and open an existing abstract that was previously submitted, follow the instructions 
under ‘Search For and Open an Abstract’ in this user’s guide. 

2. Make any updates or corrections to the abstract and save the changes.  Close the abstract. 

3. Click on the File menu and select Export Abstracts. 

Result:  The Export Abstracts window opens, and presents you with different options for 
exporting abstracts. 
 

 

4. Click M Type Record and hit Select. 

Result: The system displays the number of abstracts that meet the export criteria. 
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5. Click OK. 

6. Click Export. 

Result: The Save As window opens. 

 
 

7. Enter your PCR four-digit Hospital ID#, the month/year, your initials and the letter M with 
no spaces (for example:  1509jan15emrM) in the File name box and click Save. 

Result:  The following message will appear.  Click OK. 

 
Result: The system saves the abstracts into a text file and lets you preview a report that you 
can print.  The PCR does not require a copy of this list.   

Click on Close to exit out of the preview report. 

8. Click Close to exit the Export Abstracts window. 

9. Upload the Modification record file in Web Plus as a V15 file.  Write ‘### M records’ in the 
comment box indicating the number of M records being submitted. 
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APPENDIX A: STANDARD KEYBOARD SHORTCUTS 
 

Function Keyboard Combination 

Menus 

File Menu Alt+ F 

Administration Menu Alt+ M 

Utilities Menu Alt+ U 

Reports Menu Alt+ R 

Options Menu Alt+ O 

Help Menu Alt+ H 

Right-Click Menu: 

Search Help / Field Context F1 

Edits Information F2 

Field Message F3 

Special Field Lookup F4 

CS or Age calculations F5 

Run EDITS on current Abstract F8 

Undo text change Ctrl+ Z 

Cut selected text Ctrl+ X 

Copy selected text Ctrl+ C 

Paste text from clipboard Ctrl+ V 

Delete selected text Alt+ D 

Select All text in entry field Alt+ A 

Move to first Text Field Ctrl+ T 

Section Headings Alt+ S 

Display Types Alt+ T 

General 

Open a pull-down data item listing Alt+ Down Arrow 

Place a carriage return in NAACCR Text fields Shift+ Enter 
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